Toad Tips & Tricks
Maximizing your Oracle productivity
Jeffrey D. Smith aka @hillbillyToad

Copyright 2011 © by Jeff Smith. All rights reserved.

Foreword
I have used Toad for 10 years; since I made the leap from Access to Oracle. Most of my time is spent in the editor, writing new code or opening and running one of the many snippets I have saved there over the years. Toad makes me more efficient, the latest version reminds me of errors before I even hit compile. Using code review, there is an instructor standing over my shoulder every time I hit format. I work in a small IT group and wear many hats. Everything I need to do in Oracle, I do in Toad. From simple data or whole schema imports, exports, and comparisons to building out completely new projects it’s a click or two away. And even while Toad has made me more efficient and my job easier to do right, it is the community around it that makes it more than just software. From forums and mailing lists to blogs, users from all over enjoy sharing and discussing all that it can do. I'm sure there are some tips in here that I will be trying out real soon.
Jim Graham
Database Developer
September 15, 2011

Introduction
Toad for Oracle has been the community’s tool of choice for more than a decade. You are a member of an elite community of 2,000,000+ developers, DBAs, and Oracle technologists.

Whether you are new to Toad, or have been using it for several years, there are a number of features that you should be familiar with for achieving maximum productivity. This book will step you through some Toad fundamentals, breaking down the features by the following areas:

- Standard features – functionality provided by the base edition of Toad
- Xpert features – Toad’s proprietary SQL and Index optimization technology
- Database Administration features – discusses how Toad can help a DBA or Development team manage their Oracle environments with Toad
If you are already a Toad customer and do not have access to the features being discussed below, please contact your Quest Sales Representative and request a complimentary 30-day evaluation license key.

## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toad Tips &amp; Tricks</td>
<td>1</td>
</tr>
<tr>
<td>Jeffrey D. Smith aka @hillbillyToad</td>
<td>1</td>
</tr>
<tr>
<td>Schema Browser</td>
<td>3</td>
</tr>
<tr>
<td>Editor</td>
<td>7</td>
</tr>
<tr>
<td>Data Grids</td>
<td>15</td>
</tr>
<tr>
<td>Handy Utilities</td>
<td>21</td>
</tr>
<tr>
<td>Querying Databases other than Oracle</td>
<td>24</td>
</tr>
<tr>
<td>Standard Edition Summary</td>
<td>26</td>
</tr>
<tr>
<td>Toad for Oracle Professional Edition Features</td>
<td>27</td>
</tr>
<tr>
<td>Toad for Oracle Xpert Edition Features</td>
<td>29</td>
</tr>
<tr>
<td>New for v10.6, Plan Control</td>
<td>35</td>
</tr>
<tr>
<td>Database Management Made Easy - DB Admin Module</td>
<td>36</td>
</tr>
<tr>
<td>Bonus Content!</td>
<td>40</td>
</tr>
<tr>
<td>Where can I get more help with Toad?</td>
<td>43</td>
</tr>
<tr>
<td>About the Author</td>
<td>43</td>
</tr>
</tbody>
</table>
Toad for Oracle Standard Edition Features

Regardless of your job title or responsibility in your organization, if you work with Oracle, then you will need a quick and efficient way to access the data in your database. This part of the document will step you through how to browse the contents of tables, write your own custom queries, and view the relationships of your database objects.

This section also discusses Toad’s powerful features available for developing and maintaining your PL/SQL stored procedures.

Toad users will generally spend most of their time in two areas, the Schema Browser and the Editor.

Schema Browser

The Schema Browser is your gateway to the database objects in your Oracle instance. Simply select the user/schema, database object type, and database object on your left, then immediately gain access to all the pertinent information for that object on your right.

Customizing the Display

Most tools offer a single display model for objects in the database. Toad offers three! Toad can display your objects in a treeview, dropdown selector, or tabbed panel.

Tree View

_Pro-Tip:_ Selecting ‘Dropdown’ will give you the most amount of real estate for listing objects and allow you to use the keyboard to navigate the object type list. Selecting ‘Treeview’ will make Toad look and feel more like SQL Navigator or SQL Developer.
Basic Navigation
Find your object on the left-hand-side (LHS). Select it, and the meta-data or details for selected object will appear on the right-hand-side (RHS). As you click around the database, Toad builds a historical list.

Quickly navigate to objects you’ve browsed to previously using the ‘back’ and ‘forward’ buttons on the RHS toolbar.

Filtering
By default, Toad will display all objects you have access to in the database. If you are working in a system with many thousands of objects, this can quickly become overwhelming and impact your productivity. Toad offers several levels of filters.

Hiding Schemas/Users
The Schema Browser allows you to create groups of schemas for each database you connect to. For example, you could create a group called ‘Oracle Test Data’ that contained the ‘SCOTT’, ‘HR’, and ‘SH’ accounts. Create custom groups to manage your production and test accounts or your different application schemas. Schemas you access on a much rarer basis would be ‘hidden’ under the ‘Other Schemas’ category.

To get started, right-mouse-click on the schema selector (or a schema node in the treeview) and select ‘Customize.' This will open the ‘Customize Schema Dropdowns’ dialog. From here you can assign schemas to as many groups as you would like.

Also applies to the Object Palette
**Pro-Tip**: Tell Toad to only load schemas that own objects! Right click on the schema selector or set in the View > Toad Options dialog on the ‘Schema Browser Page’

**Filtering Object Lists**
Each object type has an independently defined filter. By default Toad will show all objects for the selected type.

- Quick Filter – a basic pattern matching input box. You can input ‘C*;D*’ for example and have only objects that start with the letter ‘C’ or ‘D.’ This control does not support regular expressions. For v10.5 and higher, the filtering clause is applied ONLY to the selected object list. So if I define a filter while the ‘Tables’ object list is active, the filter will not apply to ‘Views’
- Project Filters – see below
- Filter Dialog – a much more powerful control. Read about this topic in depth in my blog post on Toad World

**Data Grid Filters**
You can also filter the data displayed in any data grid, not just ones found in the Schema Browser. [Skip ahead to Data Grids section](#).

**Organizing Objects**
If you are working on a project that will require frequent access to specific list of objects across object types and schemas, then you may benefit from the ‘Favorites’ panel in the Schema Browser.

**Favorites**
Add regularly accessed objects to the favorites tab by right clicking on the object and selecting Add to SB Favorites. Favorited items are managed by folders. Folders allow you to manage multiple lists.
Projects

If you want to extend the Favorites concept beyond database objects, then I recommend checking out the Project Manager. Add database objects to a Project by mouse-right-clicking on an object(s) and selecting ‘Add to Project Manager’. Having a Project defined will also allow you to filter your object lists in the Schema Browser by Project. This can be handy when you are logged into a 30,000+ object schema that contains tables for 30 different applications and you only want to see the ‘Payroll’ tables versus everything.

You can learn more about the Project Manager by reading my Tutorial on Toad World.

Additional Detail View
Toad displays by default all of the detail information for your objects on the Right-Hand-Side (RHS). You can manually add any of these detail items to the Left-Hand-Side (LHS) by mouse-right-clicking in the column header on the LHS. For example you could add ‘Num Rows’ for Tables and sort by table size stats for estimated number of rows.
Mouse-Right-Clicking
Many of Toad’s power features are exposed by using your mouse. Right-clicking on a table in the Schema Browser will expose more than 35 different operations. If you rely on having a button available on the screen, you may be missing out!

Overwhelmed by the Toad interface? Read my blog post on how to simplify Toad.

Pro-Tips:
1. Multi-select objects, then right-click
2. Where you right-click will determine what you see: grids, toolbars, menus, grid headers, etc.

Editor
Toad has a single editor for working with SQL and PL/SQL objects. Older versions of Toad had separate editors.

Freaking out because you’re used to having a SQL and PL/SQL Editor? Read my blog post.

The former SQL Editor, PLSQL Editor, and offline editors have been condensed to a single window for all of your SQL, PL/SQL, anonymous block, SQL*Plus script, etc. editing and ad hoc querying the database.

The editor is for building and executing your Oracle commands. Anything you can execute via SQL*Plus can also be executed via Toad’s Editor. This includes:

- Anonymous blocks
- SQL, DDL & DML
- PL/SQL
- RMAN commands
- Stored Java Procedures
- SQL*Plus scripts

Writing Code from Scratch
An empty editor might seem like more of a ‘blank screen of panic’ for those less comfortable with Oracle’s syntactical rules and commands. Toad has many of these commands built-in and available to invoke on-demand.
**Code Templates**

Code templates are commonly written PL/SQL blocks of code that you can have generated on demand. As an example, try typing the following into a blank editor:

```
anon <Ctrl><Spacebar>
```

This will activate the anonymous block code template.

Each template has a name, description, and code component. Typing the name followed by the `<Ctrl><Spacebar>` key sequence will activate the template. If no text is at the current cursor position, then a popup list of all the templates will appear for you to select.

The default templates can be modified by right-clicking in the Editor and choosing “Editing Options.” From there you will default into the behavior portion of the Editor options. Click on the ‘Code templates…’ button.

Templates can be extended, modified, removed, and even shared with other Toad users.

---

**Pro-Tip:** Make your templates dynamic by using the & character

---

**Code Insight**

Toad can help you write your SQL and/or PL/SQL statements. As you type, Toad can offer to complete the command or object name for you. The Code Insight feature has been remarkably improved over the past several releases. As you may remember from older versions, Code Insight (<ctrl>+<Period> from the editor) allows you to quickly browse and select tables in the editor. Code Insight has the ability to see the following object types:

1. Tables
2. Views
3. Aliases
4. Functions|Procedures|Packages (with methods)
5. Types (with attributes and methods)
6. Java Source
7. Sequences
8. Users
9. Expected Tokens (keywords)
10. Available Variables/Parameters
11. Collection Types
12. Public & Private Synonyms

Pro-Tips
1. You can disable this feature completely or partially
2. Disable support for Expected Tokens

As an example, I want to query from a schema that starts with ‘matthew’. Toad will recognize that text and popup a complete list of accounts that match that string.

```
Select * from matthew
```

For performance reasons, not all object types are enabled by default, in particular the public synonyms. So if you are looking for help referencing a DBMS_ package, you will need to preface it with the ‘SYS.’ Notation, or enable the Public Synonym support.

All of the Code Insight options can be found on the Editor, Code Assist page in the Options dialog.

To disable code insight, uncheck the ‘Enable Code Insight pick list’ option. You can still invoke the code assistance feature on-demand by using the ‘CTRL’+’Period’ key sequence.

A less drastic approach would be to increase the timer delay to something like 5000. This would give you a good 5 seconds before Toad attempts to auto-complete your text.
F4/DESC
If you have ever used SQL*Plus, you are probably familiar with the DESC command. DESC gives you a table or view definition. Toad has its own DESC command, and will work on any object in the database! If you do not ‘know’ F4, then you do not know Toad!

To use Toad’s DESC, simply put your cursor on an object name you have typed in the Editor and use the F4 key. This will open a popup dialog that gives you all of the same information you would see in the Schema Browser.
**Pro-Tips**

1. You can DESC as many objects as you want
2. You can drag column names into the editor
3. You can modify the object from the DESC
4. Read more about DESC on my blog

**Recall Previous SQL**

Every valid SQL statement you execute via F9 is automatically recorded by Toad. You can access previously executed SQL by using F8. The same panel is available under the View menu. By default Toad stores the last 500 executed statements.

*Pro-Tip:* You can cycle through your list of previously written SQL statements using `<ALT> + <Up Arrow>` or `<ALT> + <Down Arrow>`. You can do this on selected text to do a limited replacement.

Giving your SQL Statements a name allows you to recall your query by context versus some obscure SQL you may have written six months ago. My advice: if you spend more than 30 seconds writing a SQL statement, give it a name! You can now recall without using the F8 dialog, giving you more room to type in the editor. Use `<CNTRL> + N` to popup a list of named SQL statements. Selecting one will put the SQL in your editor.

*Looking for help on how to execute statements and scripts? [Read my blog.]*
Split Editor

New for v10.6! If you are working on an extremely large block of code and want to view/edit multiple sections simultaneously, mouse-right-click in the editor panel and choose ‘Split Editor Layout.’ You can use either a ‘Top/Bottom’ or ‘Left/Right’ theme.

Make Code Statements

Toad supports 6 different programming languages (C++, Delphi, Perl, etc), chosen through the Options menu, for creating code statements based on SQL, or for stripping non-SQL syntax from a code statement. To take a SQL statement and automatically format it to be embedded into a Java program, for example, we need to simply select “Make CODE Statement” from the Editor menu. This will copy the current window’s statement to the clipboard in whichever language’s syntax the user has chosen. The next step is to paste the formatted SQL call into the code. You can extend this feature to the programming language of your choice by adding it manually in the Options dialog.

Format Code

Easily transform chaotic, untidy code into easily managed aesthetically pleasing code by right clicking in the editor and selecting the icon showing two yellow arrows. Under the menu option “View,” select “Formatting Options” to customize how the code will be formatted.

Leading or trailing commas? Join the debate!
Working with PL/SQL
Toad is a full featured IDE that allows a PL/SQL developer to accomplish the following quickly and easily:

- Create PL/SQL stored procedures
- Execute said procedures
- Identify syntax errors
- Debug PL/SQL objects
- Perform automated code reviews
- Document the PL/SQL objects
- Identify execution bottlenecks
- Load test the PL/SQL objects
- Unit test the PL/SQL objects
- Capture REFCURSOR output
- Refactor PL/SQL
- Control PL/SQL via Source Control

To cover these topics in detail here would make the book many pages longer and likely try your patience. Instead I will cover a few of my most favorite and overlooked features. You can learn more about the other features on ToadWorld.

Execution Profiling
Toad allows you to profile your PL/SQL executions to determine where any execution bottlenecks are occurring, e.g. ‘Why is my program taking so long to run?’ To start a profiler run, toggle ‘on’ the ‘stopwatch’ button next to the ‘debug’ toggle. Then execute your PL/SQL program from the Editor. After it is finished, pull up the record from the ‘Profiler’ tab. With version 9.6 and higher, you can now automatically pull up the visual chart representations of your PL/SQL runs by clicking on the ‘Details’ button.

Quickly determine which line of code is taking the most time to run.
Toggle on the 'Details' view to see a graphical representation.

If you are on 11g or higher, then Toad also supports Oracle’s Hierarchical Profiler.

**Debugger**
A developer’s best friend for figuring out why your program isn’t behaving as expected. Run your program line-by-line, by ‘stepping’ through the code.

1) **Set Breakpoints** To set execution breaks in the code leave the cursor on the line on which you wish the code to break and hit F5. Set conditional breaks by double clicking the break in the “Break and Watch view window.” Make sure to only add breakpoints that are ‘executable.’ These are marked by little blue dots in the editor gutter for each line. Non-executable lines will not have their breakpoints honored by Oracle.

2) **Add Watch** To add a watch on a variable, leave the cursor blinking on the variable on which the watch is desired and click the eyeglasses icon. New for v9.5, you can see the values of all of your code variables by using the ‘Enable Smart Watches’ feature.

3) **Modifying Variable Values While Debugging** To artificially change the value of one of your PL/SQL variables, highlight the variable in the watch window and hit the calculator on the icon bar which, once moused over will read “Evaluate/Modify Watch”

*Looking for an Alternative to Debugging? Read my blog on how to get Toad to generate your DBMS_OUTPUT scenarios automatically (new for Toad v10.5)*
Running SQL Inside of PL/SQL
While most of you know that you use F9 to execute a single SQL statement, did you know you can use <CTRL>+<ENTER> on embedded SQL in your PL/SQL code? New for v11, Toad will ‘extract’ the SQL and attempt to execute it. Any variables will need to be assigned, but Toad will ask you for required values.

Data Grids
You may be asking why I took so long to get to the most important feature! Well, the data grids are integrated into multiple Toad windows. So while it is tied to both the Editor and the Schema Browser, it is not a stand-alone feature. The following are a few tips and tricks for getting more out of the grids.

Sorting/Filtering
If you want to apply a sort or filter on your data via the Grid, then Toad makes that pretty easy. Note that this feature is not available for grids in the Editor.

If you want to apply multiple SORT conditions, then use the ‘Sort’ panel to assign a condition for each field. You can also decide how
NULLs should be treated.

Filtering is available in several different mechanisms.

*Pro-Tip*: The easiest way to apply a filter is to click into a cell that has the value you want filtered on, then click on the filter control and choose ‘Add to filter…CURRENT VALUE.’
Filter condition copied to dialog

Result set refreshed with active filter.

A few notes about the filter dialog:
- Filters can be named for easy recall
- The WHERE clause can be manually inputted
- You can use different conditions like BETWEEN and NOT IN
- Filters are remembered between sessions. If the funnel control is colored RED, then the filter is active.
Column Management

You can easily disable a column in a grid by using the Column Selector at the top left hand corner of each grid.

Columns can also be re-ordered by dragging the column header with your mouse to the desired location in the grid.

Each change will be reflected when data is copied or exported out of the grid. You can restore the grid to its original state with the mouse-right-click ‘Reset columns’ command.

Pro-Tip: Fix a column. After a column is ‘fixed’, as you scroll left and right in a grid, that column remains ‘fixed.’ You may fix as many columns as you would like.

New for v10.5, users can apply grouping at the column level. You will need to activate the Group Panel via mouse-right-click. Then simply drag a column to the panel space to apply a group condition. You can have multiple levels of grouping.

Grouping makes it easier to drill into specific rows for analysis and reporting.
Card View
Toad has a Single Record View that allows you to view records one at a time vertically. Click on the open book button to start using this feature.

Grid Styles
You can now apply a visual color style to the data grids in Toad. This can lessen eye strain when having to stare at millions of rows of data all day long! To apply a style, open the options and go to the Data Grids, Visual page.
**Calculated Fields**
New for v11, Toad can now count, sum, average, min, and max selected numerical values in a grid! Simply select the cells you want to perform the calculation on, and then hit the new ‘Sigma’ button on the data grid toolbar.

**Pro-Tip:** You can select values across multiple columns. Once calculated, you can copy and paste the data from the bottom panel.

**Super Pro-Tip:** New for v11, the Schema Browser has a new ‘Show Detail Dataset’ button. This allows you to see children records for the selected row. Read more in my blog post.

**Reporting**
To access Toad’s reporting interface, right click in the Data Grid and select ‘Report.’ You will find a report generation wizard to walk you through report creation. My friend Gary Piper has a lot of great material on doing more with Toad Reports on Toad World.
Handy Utilities

**ER Diagram**
Generate an Entity Relationship Diagram (ERD) by selecting the objects you want diagrammed in the Schema Browser and right-click -> “ER Diagram.”

You can easily export the visual diagram to a full rendered HTML version that anyone can interact with outside of Toad. If you need to alter models and push migration DDL scripts or compare models, you will need to use Toad Data Modeler, which is free to use for all licensed users of Toad for Oracle who are also current on maintenance. The diagrams are generated by reading the foreign key constraints defined in the database.

_pro-tip:_ If you have a database that does not use foreign keys, then you can use Toad Data Modeler to reverse engineer a schema and use the ‘Infer Relationships’ feature to guess relationships based on common column names between tables.

Any ERD may be exported to a what-you-see-is-what-you-get HTML report. [Interact with an example report.](#)

**Code Road Map**
Similar to an ER Diagram, but from the stored procedure (PL/SQL) perspective, the Code Road Map parses an object’s source code and identifies the other Oracle objects it is dependent on. If a view calls from 6 different tables, then Toad can diagram that. Or, if your PL/SQL function makes a package call which is dependent on a table and sequence, then it will diagram that.
Choose your Trigger/Procedure/Function/Package in the Schema Browser and right-click -> “Code Road Map.”

The reporting for Code Road Maps is identical to ER Diagrams. Note you can also use the ‘Create Script’ button to generate a DDL script to build a test or dev sandbox environment where everything to compile and execute your PL/SQL is present, saving you the need to copy an entire Schema to test a single object.

Pro-Tip: You can also use the Code Road Map to build a diagram for your Views.

Query Builder (Formerly SQL Modeler) - allows for building queries visually. Did you know that this was the most frequently cited feature in Toad for saving time in a recent user survey? That’s right: more people said this window saved them more time than any other feature in Toad.

The next time you need to query from more than 2 or 3 tables, try the Query Builder! Who wants to type out all the SELECT, FROM, and JOIN clauses? This window also makes it very easy to build WHERE clauses around DATE values in a table with a value picker – much like using the Filter dialog for the data grids.

A few key features:
1) Select Tables Using the Object Palette (opened automatically), select one or more tables or views necessary for your query and drag them into the workspace.
2) View Joins If the tables have relationships defined by Referential Integrity Constraints (Foreign Keys), Toad will automatically detect these and join your
tables/views. Double click on a link to view or change the join condition for your query.

3) **Choose Columns** Double click in the check boxes of the columns desired for the query

4) **Add Where Clause Criteria** Drag a selected column from the ‘SELECT’ tree area and drop it on the ‘WHERE’ area. You can also mouse-right-click on a column in the tree and select ‘Include in Where Clause.’ This will open the ‘Where Definition’ window. Click on the ellipsis button to see distinct values for the selected field to help you build a meaningful where condition.

5) **View Generated Query** View the SQL by looking at bottom of the screen.

6) **Run Generated Query** Run the query with the F9 key or the green play button to return a data set.

7) **Explain Plan** View the explain plan by clicking on the ambulance icon on the second of the top two icon bars
8) **Create a model from existing Query** - From the Editor right click and select “Send to Query Builder” to reverse-engineer your selected query to a Query Builder model

*Pro-Tip:* Toad can write your joins using ANSI join syntax. This is ideal for applications supporting both Oracle and SQL Server environments.

---

**Querying Databases other than Oracle**

**Introducing Toad for Data Analysts**

If you enjoy Toad’s interface for Oracle, you will be pleased to know that a similar Toad product is available for other databases! You will be even happier to hear that this tool is automatically included with every copy of Toad for Oracle!

The particulars:

1. Connect natively to the following non-Oracle databases:
   a. IBM’s DB2, LUW and z/OS
   b. Microsoft SQL Server
   c. MySQL
   d. Sybase ASE, Anywhere, IQ
2. Connect via ODBC to other databases, including:
   a. Teradata
   b. Informix
   c. PostgreSQL
   d. Any datasource that supports the ODBC v3 protocol
3. Quick connect to MS Access and MS Excel w/o ODBC configuration for querying, reporting, and exports/imports!
4. Build queries visually or use the familiar Toad editor to get to your data
5. Browse the contents of the database using a single Browser (just like Toad for Oracle!)
6. Compare and Synch DATA between different databases

Pro-Tip: Watch the movie!

7. Rich MS Excel integration, build pivot tables and ODBC linked queries on the fly!
Toad for Oracle now includes Toad for Data Analysts which extends our powerful browsing and querying technology to other RDBMS platforms!

Notes regarding this feature:

- Toad for Data Analysts is available for any Toad for Oracle user that is current on maintenance.
- If you need to perform database administration or application development tasks, then be aware Quest has specific Toad IDE’s for those platforms, e.g. Toad for MySQL, Toad for DB2, Toad for SQL Server.
- Your Toad for Data Analysts license is provided via Toad for Oracle and cannot be transferred to another person.
- Toad for Oracle remains your ‘Go To’ tool for anything Oracle. Toad for Data Analysis is provided here to give you access to the data in sources other than Oracle.

Standard Edition Summary

As you can see, the Standard Edition of Toad is packed full of features. And to be honest, we barely covered 10% of them! As you know, Toad is available in multiple editions. The rest of this document discusses premium features available with the Professional, Xpert, and DB Admin module upgrades.
Toad for Oracle Professional Edition Features

Generate Test Data for one or more tables automatically! Need more and better looking test data to drive your applications? Toad can do that in a couple of clicks!

**Pro-Tip:** Toad’s Professional edition allows you to select one or more tables and generate test data. Toad will even honor your foreign key relationships when creating key values. Toad can generate real-looking product data.

Also included with the Professional Edition is Code Analysis, Toad’s revolutionary SQL and PL/SQL Automated Code Review and Documentation system. Learn more about Code Analysis and how to generate CRUD matrices.

Don’t let code reviews become an expensive and sensitive situation for your development teams. Toad is the ONLY PL/SQL IDE that offers best practices programming advice for your Oracle developers.
Need even more help with your PL/SQL development tasks?

The Toad Development Suite for Oracle introduces a full load and functional testing suite for your PL/SQL code.

Generate functional tests for your PL/SQL without writing any PL/SQL code!

Describe in plain English the behavior of your PL/SQL program, and let Toad generate and manage your test code. Run a regression test anytime you make a change to your program.

*Pro-Tip:* Run to test! Run your PL/SQL program and have Toad record the observable behavior as your unit test. Regression testing is only a click away!

Test Performance

You are only a right-click away from load-testing your stored procedures in Toad as well. Put your code to the test by spinning up a hundred concurrent sessions. Find out when your performance service level agreements fall apart.
Toad for Oracle Xpert Edition Features

Toad for Oracle’s Xpert Edition includes a comprehensive SQL Optimization solution which will identify problematic SQL, tune statements automatically, suggest index alternatives, and even provide impact analysis when implementing changes that could negatively affect database performance.

Wherever you encounter SQL in Toad, you can also invoke a tuning session for that statement by simply pressing the “Auto Optimize SQL” button.

Tuning Current Statement from the Editor
When handling a problematic SQL statement in the Editor in Toad, it is very easy to move the statement into our tuning lab. Just select the SQL you want to tune, and hit the ‘Optimize SQL’ button. Again, it is the Yellow Beaker with the Tuning fork (Found on the right of the printer button.) You will then be prompted to send the SQL code to the Optimize SQL or the Batch Optimize screens. I recommend you become comfortable with the Optimize SQL window which allows you to manually tune a query before you use the automatic Batch Optimize technology.

Pro-Tip: When using the stand-alone Quest SQL Optimizer, right-mouse-click on the toolbar and select ‘Show Captions’

Optimize SQL
The Optimize SQL window guides the user from analyzing the current execution plan to automatically generating SQL query rewrites that will identify better performing queries. Toad can generate and evaluate the theoretical execution plan.
The SQL Information tab under the plan will let you know if there are any problems with your plan that could impact performance.

You can view the plan in several different formats and even get detailed documentation for each plan step – all by mouse-right-clicking!
Toad for Oracle Tips and Tricks

Ready to tune?

With your statement in the ‘Optimize SQL’ window and ‘SQL Details’ panel, you have several options:

- **Optimize** – ideal for fast running queries, this will automatically re-write the SQL and execute each unique execution plan. You will be notified as soon as a faster alternative has been identified.
- **Rewrite** – ideal for long running queries, this will JUST rewrite the SQL statement and allow you to evaluate each unique plan that has been identified. You can then decide which queries you want to test by executing them.
- **Index** – ideal for product and application environments where the SQL statements are not available for rewrites. This will generate virtual indexes and allow you to see the new execution plans available before you physically create the index. If you test these scenarios, the indexes will be created and the original queries executed to verify the performance has improved.
- **Rewrite & Index** – Does both rewrites and index scenarios.
As each scenario is executed, they are ranked by Elapsed Time. You can cancel execution at any time, or let it continue through all of the rewrites for a more exhaustive set of scenarios.

You can easily compare any two scenarios by seeing both the SQL syntax and execution plan differences side-by-side.
Advise Indexes
The indexing feature will analyze a collection of SQL statements to see which tables and views are being queried, and then will examine the existing set of indexes. It will then generate a list of alternative indexes you can evaluate for optimal execution of your original SQL statements. We recommend the SQL Query re-write tuning methodology whenever possible as adding indexes to your system can affect the performance of other SQL queries found in your code and views. If you need to create a new index, then be sure to use our Impact Analysis technology.

Analyze Impact
Whenever you add one or more indexes to the database, the execution plans for your applications’ embedded SQL can be dramatically impacted. The Impact Analyzer allows you to model these proposed system changes so you can see exactly how your new index affects everything else in the database. We generate the new theoretical index and the new execution plans for each of your production SQL statements. You can see what the before and after ramifications are to your system whenever you propose a change.

Pro-tip: Identify key SQL code, propose a change to the system (a new index?), then see how that change affects the execution plans for your SQL code.
Optimize Current SQL – While in the Toad editor, you can now invoke a tuning session to run inside of Toad for the current SQL statement. This interface will automatically generate alternatives and execute them, alerting you to alternatives that generate faster execution times. This is ideal for tuning scenarios involving queries that run in terms of minutes or seconds versus hours. If you are looking for an interactive tuning environment where you have more control, you should continue to use the Quest SQL Optimizer interface. However, if you are new to tuning SQL, then this feature is much simpler and is definitely worth a look.

When launching a tuning session inside of Toad, you’ll be asked to choose between an OLTP or Data Warehouse environment, a ‘Search Depth’ which determines the number of re-write alternatives to investigate, and provide an optional time limit for the re-write and execution exercise.
You can now generate SQL re-writes and identify more efficient alternatives for your poorly performing SQL directly inside of Toad.

New for v10.6, Plan Control
It is not always possible to implement a query re-write, especially in production, to solve a performance problem. Oracle has introduced a new query performance management feature in 11g to address this, known as SQL Plan Baselines.

With the touch of a single button, Toad was able to evaluate 60 different plans. After testing them, it identified one that took the response time from 43 seconds down to 6 seconds! We can now deploy this to the database without making any changes to the application source or worrying about introducing any SCHEMA changes that could affect other parts of the application (like an INDEX).
Database Management Made Easy - DB Admin Module

Toad is not just for developers! Database administrators have access to features tailored to their needs. Any copy of Toad can be upgraded to include Toad’s advanced database object management features with the DB Admin module. Whether you need to create test environments based on existing instances, manage database resources, or compare and synchronize different instances, the DB Admin module may be right up your alley. This portion of the document will take you through some of the more helpful features.

Health Check (Database > Diagnose > Health Check)

Wouldn’t it be nice to give each of your instances a thorough medical checkup? With Toad’s Health Check, now you can! Select the instances you want inspected, select the scenarios you want evaluated, and hit the play button. This feature can be scheduled, and you can have the results automatically emailed to you so you can see what’s what in each of your managed instances. For example, we can automatically identify ORA-600s in your Alert Logs or audit synonyms that point to non-existent objects.

Pro-Tip: Easily create multiple types of health check scans that run on selected instances on given days of the week and email the results to the DBAs responsible for those instances/database tasks.

New for v10.5, the Database Health Check now includes 16 checks for Oracle RAC environments! Version 11 has introduced new checks for production and virtualized environments.
Database Browser (Database > Monitor > Database Browser)
Most users will rely on the Schema Browser for poking around the database, but for DBAs, Toad offers the Database Browser for more effective instance management. Toad’s Database Browser allows you to connect to all of your databases and interact at the database level (users, roles, tablespaces, system privileges, etc.). You can select multiple instances and see the parameters set for each side-by-side, or you can drill down into the objects of the database just like you can for the Schema Browser.

The Database Browser serves as your entry point to running most of the database level utilities in Toad. Start a health check, look for the most expensive sessions, startup or shutdown the instance, all with a single click. New for version 9.7, Toad now offers the ability to setup and run your database backups with our Recover Manager (RMAN) integration.

Statspack Browser (Database > Monitor > Statspack Browser)
Statspack allows you to see what was happening in your database for a specific period of time. For example, what tablespaces were most frequently read and written to in the last 24 hours? Toad allows you to answer this question in a few seconds. Additionally, you can use Toad to manage the Statspack statistics collection jobs and the snapshots it queries from.

Pro-Tip: Licensed for the Diagnostic Pack? Toad also offers an Automatic Workload Repository (AWR) browser and access to all of your ASH and ADDM reports.
Zooming into a chart allows you to highlight chart lines or export the data to MS Excel.

Trace File Browser (Database > Diagnose > Trace File Browser)
Tired of using TKprof to analyze your trace files to see what is causing your database to run at less than peak performance? As of version 9.7, you can now visually inspect the contents of your Trace files. See immediately all of the queries captured with their binds, waits, and performance profiles.

Click on a query to see the binds variables and the values passed for execution.
Toad will show the number of queries that run under specific amounts of time. Drill down to an individual statement to see the Execution vs Parse vs Fetch vs Wait times so you know EXACTLY how to approach a tuning scenario.

DBAs, do you need even more help?
Ask your Quest Account Manager how you can get the Toad DBA Suite for Oracle to access our award winning tools for performing:

- Real-time diagnostics with Spotlight on Oracle (supports Data Guard, RAC, and Exadata environments)
- Database activity record and replay with Benchmark Factory for Oracle
- Reverse-engineers of existing databases for rich ER Diagrams or creating new physical or logical models from scratch.
Bonus Content!

My ‘standard’ Toad presentation has changed quite a bit since I first put this material together. Here are a few bonus topics that I have added in the past year. Most of this content is inspired by the conversations I have with my Oracle and SQL Server friends on Twitter.

Four Ways to Get Data from Toad to Excel

You want to get data from Oracle to an MSFT Excel spreadsheet. You have Toad. I know of at least 3 ways you can do this. Each have their own advantages. Let’s take a few moments to explore your options.

Copy & Paste
By far my least favorite option, this is probably also the most popular method used by new users to Toad. You select your data in the grid, Ctrl+A, Ctrl+C, ALT+TAB, Ctrl+V – voila! Your data is now in Excel. What’s wrong with this method?

Nothing.

Everything!

You need to make sure Excel is open first. You won’t get any formatting, i.e. dates won’t come over as ‘date’. If you want to format the data in Excel after-the-fact, there’s no way to automate that without creating a macro.

But if it works for you, then happy days!

Export Dataset – Delimited Text
According to the developer, this is your fastest option. Of course it won’t be an XLS or XLSX file. I just tested this and it took about 25 seconds on my machine, not counting the time Excel took to load the file. At this point I would have to agree with the developer!

Read More
Oracle Tip: You Can Bypass TNSNames

Ever spin up a database for some quick and dirty work, and you JUST WANT TO CONNECT (!!) without going through the whole ‘add the service to your local TNSNames.ORA’ rigmarole (Oracle Net Configuration Assistant)?

Oracle’s Net Configuration Assistant was one of the first JAVA powered GUIs I had run into as an Oracle user. It has been improved greatly over the past few years, but I’m pretty sure there are still much faster ways to connect to the database.

Yes, you can manage your TNSNames.ORA file manually using a text editor.

But I’m not here to talk about that. I’m here because I’m really, really lazy. I know where the database is, and I just want to connect to it. NOW.

EZCONNECT

When you just want to connect, you can put all of the connectivity information in your connection string, no need to interface with TNS. AskTom was talking about this waaaay back in 2005, and I know Oracle has supported it since at least the 8i release.

syntax

CONNECT username/password@[//]host[:port][/service_name]

Read More

Building Your Where In () Lists

Have you ever needed to write a query and filter your results with a WHERE EXISTS or a WHERE IN list of values? Your list will be comma delimited, and you'll need to quote the strings appropriately. Not so bad if you have a few values, but what if you have 42 or 420 or more? You are looking at the data in Toad, and you want to just WISH it into a comma-delimited list (and maybe quoted), to feed into your

```
SELECT ... 
FROM X 
WHERE Y IN ( 'a', 
```
Surely there is a way to have Toad build this list for you? The answer is 'YES' – and you don’t even need to learn Regular Expressions (REGEX – [wiki](https://en.wikipedia.org/wiki/Regular_expression)). As an aside, I do recommend you learn REGEX, it is definitely worth the investment of your time.

Let’s Do It!

Step One: Get your data – in other words, write your query or filter your table until you get the list of values you want to send to your query.

Step Two: Trim the extra columns

Read More

**Custom Queries**

There are SO many little nuggets in Toad that you can take advantage of. To list all of them would be a daunting task. Here’s one that you may have overlooked, **Custom Queries**.

If you right-mouse-click on an object in the Schema Browser, you’ll see a list of operations you can perform. Take a second to look at the list for ‘Tables’. I have 36 operations available. The very last entry is ‘Custom Queries.’

So what is a custom query?

A custom query allows you to build dynamic sql scripts using the selected list of objects as your WHERE clause. Toad ships with a few of these already written for you. The ‘custom’ comes into play when you create your own or tweak the defaults to match your needs.

**A Quick Example**

I need a quick inventory of constraints for a list of tables. I could select each table individually, go to the Right-Hand-Side (RHS) Constraints tab, and create a report, but that would be several steps multiplied by the number of tables I needed to audit.

Instead, I can use a custom query to do this in only 3 steps!

1. **Select your object(s)**
2. **Mouse-right-click | Custom Queries | Constraint Type Summary**
3. **Execute the query that is pasted into the editor**

That’s it!
Where can I get more help with Toad?

Toad for Oracle has more than a decade’s worth of feature development and investment by Quest Software. It has features that can’t be adequately covered or discussed even in a 40 page PDF document. For more help, please consult the following resources:

1. Your Quest Sales representative - He or she is dedicated to keeping you and your company happy with its investment in the Toad family. They can get your questions answered, provide insight on solutions at Quest that address your problems, help you with getting evaluation copies of our software, and even help you manage your relationship with Quest Support.
2. Quest.Com - Toad Product Page
3. Toad World - Online Toad User Community
4. AskToad - Toad's own Wiki site for FAQs and troubleshooting
5. Yahoo! Groups - 7,000+ Toad users worldwide answer each others questions

About the Author

Jeff Smith
Jeff Smith is a Senior Systems Consultant at Quest Software, and an Oracle ACE. He has been with Quest since 2001, working on the Toad® development, management and sales teams. He currently helps customers get the most from Toad and Quest's other database tools. Jeff is the primary author of "Toad Pocket Reference for Oracle," published by O'Reilly. He holds a bachelor's degree in computer science from West Virginia University, is a frequent contributor to ToadWorld.com and a member of ODTUG. Jeff is a regular speaker at Toad User Groups and Oracle User Groups worldwide, and serves as editor-in-chief of the Quest online resource, OraDBPedia.

- Email: Jeff.Smith@Quest.com
- Blog: http://www.thatJeffSmith.com
- Twitter: http://twitter.com/HillbillyToad
THANK YOU!